
 

 
Directorate for the Student Experience 

 
Title: Policy on Inclusive Teaching and Learning Materials 

 

Contents 
Title: Policy on Inclusive Teaching and Learning Materials ........................................................ 1 

1. Introduction .......................................................................................................................................... 2 

2. Intended learning outcomes and competency standards ............................................................. 2 

3. The Policy ............................................................................................................................................ 3 

3.4. Documents ................................................................................................................................. 3 

3.5. Electronic materials ................................................................................................................. 3 

3.6. Powerpoint presentations ...................................................................................................... 3 

3.7. Recording lectures ................................................................................................................... 3 

3.8. Reading lists .............................................................................................................................. 4 

3.9. Marking the work of disabled students .............................................................................. 4 

4. Sources of support & further guidance ............................................................................................ 4 

4.1. Documents ....................................................................................................................................... 4 

See also: .................................................................................................................................................. 5 

Creating Accessible documents in word ............................................................................................. 5 

Creating Accessible PDF Documents ................................................................................................. 5 

4.2. Powerpoint presentations ...................................................................................................... 5 

4.3. Reading lists .............................................................................................................................. 5 

Delivering Accessible Digital Learning ................................................................................................ 6 

RNIB Guidance ....................................................................................................................................... 6 

HEA Asperger Guidance ....................................................................................................................... 6 

5. Useful Tools ......................................................................................................................................... 6 

Outline view ............................................................................................................................................. 6 

Table of contents .................................................................................................................................... 6 

Navigation pane ...................................................................................................................................... 6 

Text-to-speech (TTS) ............................................................................................................................. 6 

 

Page 1 Draft University of Manchester Policy on Inclusive Teaching and Learning Materials 
 



 

1. Introduction 
1.1. The purpose of this policy is to standardise practice across the University in terms 

of the anticipation, identification and promotion of good practice in the preparation 
and presentation of teaching materials for the general benefit of all students, but 
particularly for the support of disabled students by mainstreaming a small number of 
adjustments. In this context, ‘adjustments’ refers to types of academic support that 
are typically and frequently recommended by the Disability Support Office (DSO). 
An agreed minimum level of provision will minimise the adjustments required for 
individual students, easing any additional work needed by academic staff and 
others involved in organising support for disabled students.  
 

1.2. The general principles of the policy are aimed at removing barriers for disabled 
students to access teaching and learning materials and improving access for all. 
These aspirations are in line with our duty to make reasonable adjustments under 
the Equality Act 2010. This duty requires education providers to take positive steps 
to ensure that disabled people can fully participate in their education and enjoy the 
other benefits, facilities and services which education providers provide for their 
students. 
 

 
2. Intended learning outcomes and competency standards 

2.1. Under the Equality Act, the university is not required to make reasonable 
adjustments to intended learning outcomes or professional competency standards. 
It is therefore important that any intended learning outcomes, including professional 
or other competency standards are fully understood and transparent. These 
intended learning outcomes and / or professional standards themselves need to be 
justified under the provisions of the Equality Act and we may need to make 
adjustments to how these intended learning outcomes or professional competency 
standards are met.  
 

2.2. Intended learning outcomes must be explicitly stated in course handbooks. 
 

2.3. There are guidelines produced by professional bodies and organisations which 
serve to protect the general public. Programme directors need to be guided by the 
competencies required by particular professional groups (e.g., nurses, doctors, 
teachers, psychologists etc.). Under these circumstances an adjustment would not 
be made if it meant that the student could not competently act within their field 
without the adjustment. However, it should be remembered that students may 
demonstrate that they meet competency standards in different ways. The Disability 
Support Office can advise staff with respect to competency standards and 
reasonable adjustments. 
 

2.4. Equally, an intended learning outcome could be considered to be a competency 
standard under the Equality Act. The Disability Support Office can provide further 
advice and guidance. 

Page 2 Draft University of Manchester Policy on Inclusive Teaching and Learning Materials 
 



 

 
3. The Policy 

3.1. This policy applies to all teaching and learning materials produced in the University. 
The policy applies to all students of the University and to all staff who teach and 
support students. 
 

3.2. Unless there is a justified pedagogic reason for not doing so, the policy applies to all 
courses. Such justified pedagogic reasons should be agreed with the DSO and 
must be made clear to students in advance in the course handbook. This may 
include confidential or sensitive information. However, if this is not clearly stated in 
the course handbook it is not justified. The DSO can give advice as required. 
 

3.3. The guidance in section 4 should be followed and applied. 
 

3.4. Documents 
- All documents should be produced in order to make them accessible to 

people using a screen reader. See further guidance below. 
- All documents should be produced to enable them to be accessible to people 

with average vision. A sans serif font, minimum size 12pt should be used. 
 

3.5. Electronic materials  
- Any video materials should contain subtitles or alternatively a suitable transcript 

of the content should be available for deaf or hard of hearing students.  
- Any video materials should have descriptive voice-over options for blind or 

visually impaired students  
- File sizes should be made as small as possible. 
-  

3.6. Powerpoint presentations 
- University templates1 should be used in all cases. 
- See further guidance below (Section 4). 

 
3.7. Recording lectures 

- Lecturers should facilitate the use of the Lecture Capture technology2.  
- Video recording is not permitted without the explicit consent of the member of 

staff involved, and upon recommendation as a reasonable adjustment from the 
DSO. 

- All teaching staff must ensure that microphones are turned on, worn and used in 
all lectures when they are available, regardless of the perceived need to use 
them. 
 

1 http://www.tlso.manchester.ac.uk/templates-teaching/  
2 Any lecture held in a room with lecture capture facilities will be recorded and made available to individual 
students for their own use.  The University Lecture Capture Policy applies to disabled students, and the 
right of a student who is fully registered with the DSO (i.e., they have provided complete acceptable 
evidence of their disability) overrides the opt-out option.  Students are reminded that disciplinary action 
may be taken against them for improper use of these recordings. 
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3.8. Reading lists 
- All Unit Coordinators should provide course outlines and reading lists with 

book details, chapters and relevant page numbers indicated at least 4 weeks 
before the start of the unit. 

- All Unit Coordinators should provide an electronic equivalent where possible – 
these can often be obtained from publishers.  

- See further guidance below (Section 4). 
 

3.9. Marking the work of disabled students  
- Allowances should NOT be made for spelling and grammatical errors on 

assessed work other than when a special sticker, provided to the student by 
DSO, is affixed to it. For online exams, an electronic marker is provided and this 
identifies the need for the same marking considerations. 

- Any reasonable adjustments recommended by the DSO should also be applied 
to in-class assessments. Staff will be notified separately of students with support 
needs additional to those outlined in this standard practice. 
 

4. Sources of support & further guidance 
 
4.1. Documents 

- All document structures should be kept simple.  
Screen readers (used by blind or visually impaired people) work best with 
well-structured documents. They read across a page from left to right.  

- University templates3 should be used in all cases, and staff should familiarise 
themselves with how to produce correctly formatted documents – see the 
Techdis guide4 for producing accessible Word documents.  As an example 
to colleagues, this policy document has been produced using these 
accessibility recommendations. 

- Text should be left aligned. There should be enough white space to break up 
the text. This can be done by adjusting line and paragraph spacing settings. 

- Use bullets and numbering.  
- All pages should be numbered. 
- Use the built-in header styles in Word – this then enables users to use the 

navigation pane to move around the document. 
- Use a sans serif font such as, Arial, Verdana or Calibri etc. 
- Use a minimum size 12 point font – the font should be large enough to be 

read easily by most people. 
- Write in Plain English, avoiding jargon except for technical words. 
- Make use of diagrams, flow charts, screen-shots, summary boxes and 

callouts to provide additional visual explanation. Consistently used 
pictograms can draw attention to important procedures or hazards. 

- When using tables the header row should be specified and repeated across 
different pages. 

3 http://www.tlso.manchester.ac.uk/templates-teaching/  

4 http://www.jisctechdis.ac.uk/assets/Documents/resources/AccessibleDocsGuideWord10.pdf  
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- Add meaningful ‘alt-text’5 to tables for visually impaired students 
- Images should be used in such a way as to not obscure text. 
- There should be sufficient contrast between the text and the background. 
- Where possible use non-glossy paper, off-white is preferred. 
- Use hyperlinks so that readers can easily move to information in the 

same document, a different document or a web page. 
- The easiest way to create a PDF is to create it from an accessible Word 

document or Powerpoint presentation 

See also:  

Creating Accessible documents in word 
http://www.jisctechdis.ac.uk/techdis/multlinkres/detail/main_site/AccessibleDocsGu
ideWord10 
 

Creating Accessible PDF Documents  
http://www.jisctechdis.ac.uk/techdis/resources/pdfs 
 

4.2. Powerpoint presentations 
- University templates6 should be used in all cases. 
- The layout should be simple and clear. 
- The notes field should be used to expand on important points, or to describe 

tables and diagrams. This will make the presentation more accessible for a 
visually impaired person reviewing it later. 

- The presentation should be checked and modified as necessary using the 
accessibility checker.7 

- ALT-Text and captions should always be used for any images.  
- Images must not overlap or interfere with text. 
- Any video materials should contain subtitles or alternatively a suitable transcript 

of the content should be available for deaf or hard of hearing students.  
- Any video materials should have descriptive voice-over options for blind or 

visually impaired students. 
- Be careful about the use of animation, and keep it simple. 

 
4.3. Reading lists 

- All Unit Coordinators should provide course outlines and reading lists with 
book details, chapters and relevant page numbers indicated at least 4 weeks 
before the start of the unit. 

- All Unit Coordinators should provide an electronic equivalent where possible – 
these can often be obtained from publishers. Where lecturers cannot provide an 
electronic copy of key texts, then reading lists should be provided to the library 
THREE MONTHS IN ADVANCE of the beginning of the unit. This is to allow time 

5 Alt-text (or alt tags) is used to help people using a screen reader to understand the content of images and 
other non-text content in a document.   
6 http://www.tlso.manchester.ac.uk/templates-teaching/  
7 Available in Microsoft word 2010 onwards – with the mouse click on File tab, Info, Prepare for sharing. 
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for University support services to identify or produce electronic versions of texts 
for blind or visually impaired students. 

- Reading lists should indicate priority and / or relevance so that students can 
prioritise their own reading. 

- Reading lists should clearly indicate sections that are considered to be key to the 
course or session or themes within a course. It is not expected that students 
should be limited to the texts on a reading list – instead they will be expected to 
identify further readings through their own research. 
 

Further information:  

Delivering Accessible Digital Learning  
http://www.jisctechdis.ac.uk/techdis/resources/accessiblecontent 

RNIB Guidance 
http://www.rnib.org.uk/professionals/accessibleinformation/text/Pages/clear_print.as
px 

HEA Asperger Guidance  
http://www.heacademy.ac.uk/physsci/home/pedagogicthemes/accessibility/asperge
rssyndrome 
 

5. Useful Tools 

Outline view 
This provides an outline of your document or presentation. It is available in the view tab 
in Word and in Powerpoint. 

Table of contents 
If your document is correctly formatted, then a Table of Contents can be easily 
produced from the References Tab in Word.  

Navigation pane  
The Navigation View (from the View Tab in Word) allows a reader to navigate quickly 
from section to section in your document. This pre-supposes that the document has 
been correctly formatted using the Styles available in Word. 

Text-to-speech (TTS)  
This is included with Word 2010 (PC).  The simplest way to use this is to add the TTS 
icon to the Quick Access Toolbar. To do this, go to the File Menu, and select OPTIONS. 
Click on QUICK ACCESS TOOLBAR in the left hand pane. Change the drop down 
menu labelled ‘Choose Commands From’ to see the full range of options by selecting 
‘Commands not in the ribbon’. The scroll down to select the ‘SPEAK’ command. Click 
the add button in the middle to move it to the box on the right of the screen (this box lists 
the commands that are currently available in the Quick Access Toolbar). This adds the 
SPEAK icon to the toolbar. Selecting text, and then clicking the SPEAK icon will enable 
you to listen to the text being read aloud. 
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On a Mac – the easiest way to use TTS is to use the built in OSX accessibility features 
in system preferences and enable ‘Voiceover’.  The toggle command to turn this on or 
off is cmd ⌘-F5.  
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